Summary

This application note provides the basic knowledge on how to integrate an embedded processor system with the Xilinx Multi-Port Memory Controller (MPMC) and Video Frame Buffer Controller (VFBC) IP cores in System Generator for DSP (“System Generator”). Users can then develop custom logic inside of System Generator, attach it to the imported processor system, and as shown in this example build a powerful validation platform through System Generator’s hardware co-simulation capability.

Note: This application note assumes the reader has a basic understanding of the Video Starter Kit (VSK) and has used System Generator and Platform Studio before. If the reader is not familiar with these Xilinx tools but would like to go through the design example provided with this application note, follow the step-by-step instructions in the appendices.

Introduction

This application note emphasizes the tool and design flows rather than the technology details of the IP cores. The intent is to show how to connect the MPMC and the VFBC inside of System Generator using the Xilinx ML506 hardware platform. This application note could be used with other boards by applying the same design flows and methodologies. An example video application is provided to illustrate how to exercise and validate the VFBC using existing System Generator and Platform Studio integration. It is a simplified version of the reference design that is currently available in the Xilinx Video Starter Kit.

Integrating an off-the-shelf DDR (double-data-rate) or DDR2 SDRAM (synchronous dynamic random access memory) memory controller into a system is a time-consuming and significant task. Verifying that the design runs correctly is also not trivial. The complexity of the problem is further complicated when one considers that the memory subsystem is often just a small component of the complete design.

The MPMC is a parameterizable memory controller that supports SDRAM/DDR/DDR2 memory access. It provides access to various types of external memory by using one to eight ports. Each port on the MPMC can be configured from a set of Personality Interface Modules (PIMs).

The VFBC is one of the PIMs provided by the MPMC. The uniqueness of the VFBC is that user IP or other interface circuits can read and write data in 2-dimensional sets regardless of the size and organization of the external memory. This enables users to access the external memory without having to know all of the details about the complicated external memory access protocols. Combined with the MPMC, the VFBC is an ideal solution for applications such as motion estimation, video scaling, on-screen displays, and video capture used in video surveillance, video conferencing and video broadcast.

With the MPMC and the VFBC being commonly used IP cores, it is crucial to provide seamless, transparent and easy-to-use tool flows when designing a complex system using these IP cores. Fortunately, the well-integrated tool flows between System Generator and Platform Studio enable designers to quickly put together a system in a matter of hours or days instead of weeks or months.
This section includes the following:

- “Integrated Tool Flow Based on System Generator”
- “System Generator Memory Map Interface”
- “Hardware Co-simulation”
- “System Generator Dual Clock Support for EDK Processors”

### Integrated Tool Flow Based on System Generator

System Generator is the centerpiece of the integrated Xilinx DSP design tool flow shown in Figure 1. There are two flows between System Generator and Platform Studio: the EDK Pcore generation (export) flow and the HDL netlisting (import) flow. Both flows are realized through the System Generator EDK Processor block. Users can conveniently select a flow from a pull-down menu in the block GUI.

- In the EDK Pcore Generation flow, a System Generator model is netlisted into a Platform Studio Pcore. Users can then add one or multiple copies of the System Generator Pcore as peripherals of the processor system in Platform Studio.
- In the HDL Netlisting flow, a MicroBlaze™ processor system described using Platform Studio is brought into a System Generator model. The low-level netlisting files of the System Generator model would contain the imported processor systems. Most importantly, users can run the imported processor system in hardware through hardware co-simulation for purposes such as accelerated simulation, validation and debug capability.

For both the EDK Pcore Generation flow and HDL Netlisting, System Generator provides two ways for the processor system to communicate with the System Generator model. One way is through an automatically-generated shared-memory based memory-map interface, which is described in “System Generator Memory Map Interface,” page 3. The other way is through direct port manipulation. In the EDK Pcore Generation flow, a System Generator Gateway In/Out block is shown as a port on the generated Pcore. In the HDL Netlisting flow, which is shown in Figure 6, the top-level ports of the imported project can be exposed as ports on the EDK Processor block. Users can then connect these exposed top-level ports directly with other portions of the System Generator model. It is through the exposed top-level ports that a System Generator model interacts with the VFBC IP core.
In addition to the integration with Platform Studio, System Generator also has a tight integration with Project Navigator. Users can add multiple copies of the same or different System Generator model as sub-modules of an overall design in Project Navigator. This is a push-button flow, meaning that a System Generator model can be directly added into a Project Navigator project instead of having to manually add the low-level netlist files.

**System Generator Memory Map Interface**

System Generator provides a simple abstraction for easily adding custom logic into a processor. The basic idea is to allow memories in custom logic to be easily mapped into the processor memory address space. System Generator enables this through the use of Shared-Memory blocks provided in the System Generator block set.

As shown in Figure 2, after users add shared memory blocks to the processor memory map, System Generator automatically generates a bus adapter and a memory map interface for the processor and the user logic to communicate with each other. The three kinds of System Generator shared memories (that is, the From/To Register blocks, the From/To FIFO blocks, and the dual-port BRAM-based Shared Memory block) are all supported by the automatically-generated memory map interface. Corresponding software drivers and driver API documentation are also generated to access the user logic via software running on MicroBlaze.

![Figure 2: Shared Memory Based Memory Map Interface](image)

**Hardware Co-simulation**

Using hardware co-simulation, the user can select a subsystem in a System Generator model to run in hardware while the rest of the model is simulated on a host PC. For the selected subsystem, System Generator generates a low-level implementation, attaches a hardware co-simulation module to it, and then generates an actual hardware implementation (that is, bitstream) to run on the hardware. During simulation, the hardware co-simulation module controls the clock to the design portion running in hardware and synchronizes and exchanges simulation data with the design portion simulated on the host PC. In free-running mode, the design portion running in hardware runs asynchronously with that running on the host PC. In single-step mode, both design portions run in lock-step mode.

JTAG and Ethernet point-to-point communication are the two most widely used hardware co-simulation interfaces. The JTAG hardware co-simulation is available in a wider range of hardware platforms, while the Ethernet point-to-point hardware co-simulation offers significant speed-ups in most design scenarios. This application note uses Ethernet point-to-point hardware considering the large amount of data transfer required by typical video applications.

Either the Simulink®-based or the MATLAB®-based hardware co-simulation techniques offered by System Generator can be used. The Simulink-based approach offers nice visualization and interaction with its rich modeling block set. On the other hand, using the MATLAB-based hardware co-simulation, the hardware created through the System Generator hardware co-simulation flow can be controlled through a MATLAB software scripting interface. The MATLAB-based approach offers significant simulation speed-ups over the Simulink-based approach. This is mainly accomplished by removing the Simulink modeling overheads.
System Generator Dual Clock Support for EDK Processors

System Generator supports dual clock wiring (Figure 3), which means that the imported processor system and the other portion of a System Generator model are driven by two independent clocks. One major benefit with dual clock wiring is that the MicroBlaze processor system and the System Generator user logic can run at different clock frequencies. For example, MicroBlaze can comfortably operate at 100 MHz, while a DSP FIR (finite impulse response) filter in System Generator can run at 400 MHz.

Figure 3: Hardware Co-simulation with Dual Clock Wiring

Integrating a VFBC in an Example Video Validation Platform in System Generator

This section includes the following:

- “Creating a Basic Processor System”
- “Configuring the MPMC and the VFBC”
- “Configuring the Input Clock”
- “Importing the Basic Processor System into System Generator”
- “Building the System Generator Validation Model”
- “Generating a Hardware Co-simulation Block”
- “Writing Software to Control VFBCs”
- “Performing Validation through Hardware Co-simulation”
Creating a Basic Processor System

A basic processor system can be created using the Platform Studio Base System Builder (BSB) Wizard with these two peripherals: MPMC/DDR2 and RS232_Uart. The use of BSB Wizard is recommended even for an expert user. If necessary, the basic processor system can later be manually configured to fit specific project needs. See “Appendix I: Creating a Basic Processor System Using Base System Builder,” page 17, for more details about using the BSB Wizard.

Configuring the MPMC and the VFBC

To configure the MPMC and the VFBC:

1. In the System Assembly view of Platform Studio, double click on DDR2_SDRAM to bring up the IP configuration dialog.
2. In the IP configuration dialog, select PLB46 for PORT0, VFBC for PORT2 and PORT3, and leave the other ports as INACTIVE. Set the Base Address to 0x10000000.
3. Click the Memory Interface tab and make sure that it targets mt4ht3264h-53e for ML506.
4. Accept all other default settings and hit OK.
5. Connect the VFBC ports to the top-level external ports of the processor system.

There are two ways to accomplish this task. One is through the Platform Studio GUI. The user can configure one VFBC port using the GUI and duplicate the same configuration for the other ports by directly modifying the MHS (Microprocessor Hardware Specification) text file. Refer to the MHS file provided with this application note for the manual modification. For a non-expert user, Xilinx highly recommends using the GUI over the text editing method. The process can be sped up by selecting multiple VFBC nets before adding them to external ports in XPS (see “Appendix VI: Design Iterations between System Generator and XPS”).
Configuring the Input Clock

The System Generator dual clock wiring (shown in Figure 3) is used for hardware co-simulation. The imported processor system is driven directly by the input clock to the System Generator hardware co-simulation module. The System Generator ML506 hardware co-simulation plug-in uses a 200 MHz input clock source, rather than the 100 MHz input clock source used by the BSB Wizard. Therefore, the input clock frequency of the clock_generator Pcore needs to be changed to 200 MHz.

In the System Assembly view of Platform Studio, double-click on the clock_generator peripheral. In the IP configuration dialog shown in Figure 4, change the Required frequency (Hz) of the input clock CLKIN from 100,000,000 to 200,000,000.

![clock_generator IP Configuration GUI](image_url)

NOTE: The MicroBlaze processor and its buses run at the same speed, therefore, only the MicroBlaze needs configuration.
Importing the Basic Processor System into System Generator

After creating and configuring the basic processor system, perform the following steps to connect it into a System Generator model.

1. Add an EDK Processor block from the System Generator block set library to the model.
2. Double-click on the EDK block to bring up the block GUI.
3. In the **Basic** tab, select **HDL netlisting** from the pull-down menu and import the XPS project that was created in the previous step.

After successfully importing the XPS project, hit the **Add** button and the **Apply** button to add all the available shared memory blocks in the model to the processor memory map.
4. In the **Advanced** tab, expose all of the VFBC ports (port names starting with VFBC2_) by selecting the check boxes in the Exposed column.

![EDK Processor block GUI](image)

5. In the **Implementation** tab, select the **Dual Clock** check box. Then click **OK** to close the EDK Processor block GUI.

![EDK Processor block GUI](image)
6. When targeting a Xilinx ML506 board, perform the following steps.

   **Note:** For other boards, these steps are not needed.
   - For convenience, the contents of the "edkprocessor_ddr2fix.m" utility has been added to the Initialization tab of the EDK Processor block to remove the IO pads for the MPMC/DDR2 IP cores to avoid double-buffering issues during synthesis. The utility will be executed every time the block is configured.
   - Alternatively, the utility can be manually executed by selecting the EDK Processor block and typing the following command in the MATLAB console:
     ```matlab
     edkprocessor_ddr2fix(gcbh)
     ```

7. Connect the embedded system to the System Generator control logic as shown in Figure 5. This should be the same as the uBlaze_subsystem subsystem in the vfbc.mdl model.

   ![Figure 5: Connecting the EDK Processor Block with Other System Generator Blocks](image)

   **Figure 5:** Connecting the EDK Processor Block with Other System Generator Blocks
Building the System Generator Validation Model

This section presents the top level view of the System Generator model and discusses memory-mapped shared memory blocks and the PassThru_SubSystem subsystem.

Top Level View

The top level view of the System Generator model is shown in Figure 6. The major modeling blocks and subsystems include the following.

- Embedded MALAB Function (read_YUV_420) is an embedded MATLAB function used to process input simulation text files and write stimulus signals into the video_in FIFO.
- Embedded MALAB Function (write_YUV_420) is an embedded MATLAB function used to process output simulation text files and read output simulation results from the video_out FIFO.
- The Stimulus_vector subsystem passes the frame parameters from the Simulink modeling environment to the MicroBlaze processor running in hardware.
- The PassThru_SubSystem subsystem includes the imported MicroBlaze processor system and the user logic described in System Generator. This subsystem is pushed down to the hardware during hardware co-simulation. This subsystem is discussed in further detail in “The PassThru_SubSystem Subsystem,” page 11.
- The Stop Simulation block waits for the MicroBlaze (running in hardware) to declare that it has finished processing the frame data and then stops the Simulink simulation.

![Figure 6: Top-level View of the System Generator Model](image_url)
Memory-Mapped Shared Memory Blocks

All the From/To Register blocks and From/To FIFO blocks in the System Generator model are added to the MicroBlaze memory map. That way, they can be accessed by the MicroBlaze through the provided software driver and by the user logic in the System Generator model, and vice versa.

The seven From/To Register blocks shown in Table 1 are used to pass the various simulation parameters (for example, writeFrameHeight, writeLineLength, numFrames) from the Simulink modeling environment to the MicroBlaze processor running in hardware. By doing so, customers can easily change their simulation parameters and the VFBC commands, thus significantly increasing the simulation iteration time. For example, if users want to try out new VFBC commands, they can modify and re-compile the C code and update the hardware co-simulation bit stream. After that, the users are ready to restart hardware co-simulation with the new VFBC commands. There is no need to rerun the time-consuming synthesis, map, and place-and-route to generate a new hardware co-simulation block.

Two shared FIFO blocks are used in the validation platform. The video_in To FIFO block is used to pass the input video stimulus from the host PC to the MicroBlaze processor running in hardware. The video_out From FIFO block is used to retrieve the output video data from the MicroBlaze processor and send it back to the host PC.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>WriteFrameHeight</td>
<td>To Register</td>
<td>Pass write frame height to MicroBlaze</td>
</tr>
<tr>
<td>WriteLineLength</td>
<td>To Register</td>
<td>Pass write frame length to MicroBlaze</td>
</tr>
<tr>
<td>numFrames</td>
<td>To Register</td>
<td>Pass the number of frame to MicroBlaze</td>
</tr>
<tr>
<td>ReadFrameHeight</td>
<td>To Register</td>
<td>Pass read frame height to MicroBlaze</td>
</tr>
<tr>
<td>ReadLineLength</td>
<td>To Register</td>
<td>Pass read frame length to MicroBlaze</td>
</tr>
<tr>
<td>SimStart</td>
<td>To Register</td>
<td>Inform MicroBlaze that the hardware co-simulation has started</td>
</tr>
<tr>
<td>SimDone</td>
<td>From Register</td>
<td>Wait for MicroBlaze to finish processing the data</td>
</tr>
</tbody>
</table>

The PassThru_SubSystem Subsystem

The PassThru_SubSystem subsystem is comprised of four major subsystems: uBlaze_subsystem, Video_In, PassThru, and Video_Out. During validation through hardware co-simulation, these four subsystems are pushed down to run on the hardware.

- uBlaze_subsystem (shown in Figure 5) contains a basic processor system with a MicroBlaze processor, a MPMC/DDR2/VFBC peripheral, and an RS232_Uart_Lite peripheral.
- VideoIn(VFBC3) reads the input stimulus data from the Embedded MATLAB Function block (read_YUV_420) utilizing a video_in To FIFO block. The data is then processed and stored in the external DDR2 SDRAM through the VFBC3 port.
- VideoOut(VFBC2) retrieves the data stored in the DDR2 memory through the VFBC2 port.

MicroBlaze communicates with the DDR2 SDRAM by issuing commands to VFBC2 and VFBC3 on the MPMC peripheral through the PLB interface. The video data flow is controlled by MicroBlaze, which is shown in Figure 7 and explained following the figure.
Integrating a VFBC in an Example Video Validation Platform in System Generator

Step 1: The System Generator hardware co-simulation module delivers the input video data from Simulink to the video_in FIFO running on the FPGA device.

Steps 2 and 3: MicroBlaze issues commands to the MPMC peripheral so that the video data is transferred from the video_in FIFO to the external DDR2 SDRAM memory through VFBC3.

Steps 4 and 5: MicroBlaze issues commands to the MPMC peripheral so that the video data is transferred from the external DDR2 SDRAM memory to the video_out FIFO to through VFBC2.

Step 6: The System Generator hardware co-simulation module delivers the output video data to Simulink from the video_out FIFO running on the FPGA device. The video_out simulation results are then written to <Current Directory>/level5/test00x/results/YUV.out.txt for validation purposes.

As discussed in “VFBC Transfer Commands,” page 22, each VFBC command has 128 bits. MicroBlaze sends out a 32-bit data word on each PLB transaction. Therefore, as shown in Figure 8, four 32-bit From Register blocks are used to read in commands from MicroBlaze. This user logic is used in VideoIn and VideoOut blocks.

Figure 7: Video Data Flow Controlled by MicroBlaze Block Diagram (left) and Actual System Generator Model (right)

Figure 8: Handling VFBC Commands with Four 32-bit From Register Blocks
Generating a Hardware Co-simulation Block

The basic processor system and the System Generator control logic can run in the hardware through hardware co-simulation. Make sure that all the Simulink workspace variables and other simulation parameters are set up properly. After that, double-click on the System Generator block at the hierarchy level at which the hardware is to be run. Follow the step sequence shown in **Figure 9** to generate the hardware co-simulation block.

Writing Software to Control VFBCs

After the hardware co-simulation block is successfully generated, the user can then write C code to perform various tasks, such as obtaining the simulation parameters and other settings statuses from the System Generator shared memories before issuing Read/Write commands to DDR_SDRAM through the selected VFBC ports. A polling method can also be used from a simple while-loop to check for a certain state of a valid control signal. This method is commonly used to check for a valid state of To/From FIFO Shared Memories to prevent writing to a full FIFO or reading from an empty FIFO.

The C code uses the software driver API provided by System Generator. Follow the steps in **Figure 10** to examine the API documentation of the System Generator `sg_plbiface_0` peripheral from the XPS GUI. Note that the names of the shared memories accessible through the API are identical to those found in the System Generator model.
Figure 10: Access the API Documentation of the System Generator Pcore

```c
// obtain the memory locations for writing to "V3_Cmd"
xc_get_shmem(iface, "V3_Cmd0", (void **) &vfb3_cmd0);
xc_get_shmem(iface, "V3_Cmd1", (void **) &vfb3_cmd1);
xc_get_shmem(iface, "V3_Cmd2", (void **) &vfb3_cmd2);
xc_get_shmem(iface, "V3_Cmd3", (void **) &vfb3_cmd3);

// Start Video In
viRst = 0x0;
xc_write(iface, videoInRst->din, (const unsigned) viRst);

// Poll on the videoInActive register until it reads 0x0
xc_read(iface, videoInActive->dout, &viActive);
while (viActive == 0x0) // Wait until activity begins
{
    xc_read(iface, videoInActive->dout, &viActive);
}
print("Loading data  ");
while (viActive == 0x1) // Wait until activity ends
{
    xc_read(iface, videoInActive->dout, &viActive);
}
print("done.\n\n");

// Stop and Reset VideoIn
viRst = 0x1;
xc_write(iface, videoInRst->din, (const unsigned) viRst);

// write value to "V3_Cmd"
v3_c0 = wrWidth * 4; // xSize = wrWidth*4 bytes per line
v3_c1 = 0x80000000 | stimulusStartAddr; // StartAddr = Wr:
v3_c2 = nFrames * wrHeight - 1; // ySize = nFrames * wr:
v3_c3 = wrWidth * 4; // Stride = wrWidth*4
xc_write(iface, vfb3Cmd0->din, (const unsigned) v3_c0);
xc_write(iface, vfb3Cmd1->din, (const unsigned) v3_c1);
xc_write(iface, vfb3Cmd2->din, (const unsigned) v3_c2);
xc_write(iface, vfb3Cmd3->din, (const unsigned) v3_c3);
```
One useful technique is to use a while-loop to wait for a shared FIFO to be in the correct state before performing read/write operations to it from the C code.

While it is highly recommended to use the automatically-generated API for code portability, the user may want to perform read/write operations to the shared memories directly through pointer arithmetic due to performance consideration. See the Driver Performance Optimization section in the software API documentation for more details. The complete C code is provided in the reference design files.

After finishing editing the C code, add a new Software Application Project named SysGen_VFBC in XPS, which is shown in Figure 11. Double click the Sources folder of the software project and add to it the C code located at <Current Directory>/C-code/vfbc.c.

Performing Validation through Hardware Co-simulation

This section provides information on connecting the hardware, setting up the Hyper Terminal program and input stimulus, and running hardware co-simulation.

Connecting the Hardware

1. Connect the ML506 board to the computer via a standard 9-pin serial cable. A USB adaptor may be used if the computer does not have a serial port.
2. Connect the Ethernet cable from the computer to the ML506 board.
3. Connect a 5-volt power supply to the ML506 board.
4. Turn on the power of the ML506 board.
5. If needed, refer to the System Generator User Guide to set up a 10/100 Fast Ethernet or a Gigabit Ethernet Adapter on the PC.

Figure 11: Adding a Software Application Project in XPS
Setting Up the Hyper Terminal Program

1. Launch HyperTerminal program: All Program → Accessories → Communications → HyperTerminal
2. Select File → New Connections and set up as follows:

Setting Up the Input Stimulus

If not already created, create the following subfolders:

- `<Current Directory>\level5\test001\results`
- `<Current Directory>\level5\test001\stimuli\YUV.in.hdr`
- `<Current Directory>\level5\test002\results`
- `<Current Directory>\level5\test002\stimuli\YUV.in.hdr`
- `<Current Directory>\level5\test003\results`
- `<Current Directory>\level5\test003\stimuli\YUV.in.hdr`

The `YUV.in.hdr` files are header files that contain simulation parameters. These parameters are read into the Simulink workspace during the generation of the hardware co-simulation block and during hardware co-simulation. These files may be edited directly to change the frame resolution.

Executing `stimulus_generator.m` in the MATLAB console generates the stimulus text file at `<Current Directory>\level5\test00x\stimuli\YUV.in.txt` file. This M-code file needs to be executed only once.
Running Hardware Co-simulation

Two MATLAB software scripts are provided for convenience.

- Execute `simulink_hwcs_script.m` to run the Simulink-based hardware co-simulation flow.
- Execute `matlab_hwcs_script_top.m` to run the MATLAB hardware co-simulation flow.

A rough estimation of the simulation times of these two hardware co-simulation flows is presented in Table 2.

<table>
<thead>
<tr>
<th>Number of Frames</th>
<th>800x600</th>
<th>1280x720</th>
<th>1920x1080</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulink HWCS</td>
<td>1729 sec</td>
<td>3294 sec</td>
<td>7440 sec</td>
</tr>
<tr>
<td>MATLAB HWCS</td>
<td>22 sec</td>
<td>29 sec</td>
<td>43 sec</td>
</tr>
<tr>
<td>Simulink HWCS</td>
<td>34 sec</td>
<td>51 sec</td>
<td>94 sec</td>
</tr>
<tr>
<td>MATLAB HWCS</td>
<td>45 sec</td>
<td>75 sec</td>
<td>147 sec</td>
</tr>
</tbody>
</table>

As demonstrated, the MATLAB hardware co-simulation, for this particular application, significantly improves simulation speed with the same number of frames and video resolutions. This is mainly accomplished by removing the Simulink modeling overhead.

Conclusion

This application note provided the basic knowledge on how to integrate an embedded processor system with the Xilinx Multi-Port Memory Controller (MPMC) and Video Frame Buffer Controller (VFBC) IP cores in System Generator for DSP ("System Generator"). Users can apply the same design flows and methodologies to develop other similar applications tailored specifically to their needs and design environments.

This application note presented a truly unique capability in the development of DSP hardware with an embedded processor unit using Xilinx ISE® Design Suite and the ML506 hardware board. By utilizing the tight integration within ISE Design Suite, design teams can quickly implement and iterate on a complex design as described in this application note. With System Generator hardware co-simulation capability, users can take advantage of an accelerated design validation process and leverage a similar validating platform for their designs.

Appendix I: Creating a Basic Processor System Using Base System Builder

Appendix I provides instructions for creating a basic processor system using the BSB.

**Note:** The following screen shots may be slightly different from what the user sees if different tool versions are used. If an advanced user is already familiar with the BSB, skip the following steps and build a basic processor system targeting the ML506 Evaluation Platform and configure it with the following two peripherals: DDR2 with MPMC and UART_Lite with 9600 baud rate.
1. Select Base System Builder Wizard and hit **OK**.

![Base System Builder Wizard](image)

2. Provide the Project file location and hit **OK**.

![Create New XPS Project Using BSB Wizard](image)

3. Click **Next**.

![Base System Builder](image)
4. Select **Virtex 5 ML506 Evaluation Platform** and click **Next**.

![Base System Builder](image1)

5. Select a single processor system and click **Next**.

![Base System Builder](image2)

6. Set the parameters as follows and click **Next**.

![Base System Builder](image3)
7. Use the Remove button to remove unused IO Devices and Internal Peripherals under Processor 1 at the right-hand side of the screen; click Next.

8. Click Next in the Cache configuration screen.

9. Click Next in the Application configuration screen.

10. Click Finish in the Summary screen.

Appendix II: VFBC Basics

Appendix II includes information on the following:

- “Frame Mode and Display Window”
- “VFBC Transfer Commands”

Frame Mode and Display Window

The example application uses two VFBCs, one for writing the 1080p source and one for the 480p display. The video frames are stored in external DDR2 memory. Figure 12 shows an example of a 1080p @ 60fps video source being written to a frame stored in external memory. A 480p @ 60fps display is reading a 720x480 window of the 1920x1080 source video from the stored frame.
In this example, the 1080p source video frame is stored at address 0x10000000. Assuming that each pixel is stored at 32-bits-per-pixel resolution, each pixel is 4 bytes. Because the X Size is stored in number of bytes, the X Size is 1920*4 (7680 bytes). This corresponds to the hexadecimal number of 0x1E00.

In this case the X Size and the Stride (also stored in number of bytes) are the same value, 0x1E00. The Y Size is stored as the number of lines minus one, 1080-1 (1079) or the hexadecimal number 0x437. The following table shows the command packet for the 1080p source video. For example, this packet could be written to the VFBC during each source video blank interval.

<table>
<thead>
<tr>
<th>Command Word 0</th>
<th>Command Word 1</th>
<th>Command Word 2</th>
<th>Command Word 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:15 Reserved</td>
<td>14:0 X size</td>
<td>31 Write_NotRead</td>
<td>30:0 Start Addr.</td>
</tr>
<tr>
<td>0x0000_1E00</td>
<td>0x9000_0000</td>
<td>0x0000_0437</td>
<td>0x0000_1E00</td>
</tr>
</tbody>
</table>

The 480p display in this example expects to read a 720x480 portion of the 1080p source from the external memory starting from the 360th pixel on the 120th line. The X Size for the display is 720*4 (2880 bytes). This corresponds to the hexadecimal number 0xB40. The Stride remains the same as the 1080p source command, 0x1E00 (or 1920*4) because the video is stored as a 1080p frame in external memory. The Y Size is 480 - 1 (479) or the hexadecimal number 0x1DF.

The Start Address for the 480p video display includes the line and pixel offset information and is calculated by adding (120*1920 + 360)*4 to the origin or base address of the 1080p frame. This corresponds to a final start address of 0x100E_15A0.

The following table shows the command packet for the 480p video display hardware.

**Note:** The Write_NotRead bit in Command Word 1 is now zero to denote a read transfer.
Several video functions can be performed by changing the Start Address within Command Word 1 during each video blank interval. For example:

- To cycle through multiple frame stores in external memory
- To perform a pan-scan on a 480p display of a rescaled 16:9 source when combined with a video scaler.

**VFBC Transfer Commands**

These commands are handled by both software and hardware through MicroBlaze, shared memory blocks and custom control logic.

**Line Mode**

The following example is of a 576p frame being read from external memory as individual lines. This example shows one transfer which is repeated for each line in the video. Each 576p video frame includes 576 line transfers. Each transfer has a different Start Address.

At the beginning of each line during the horizontal blank interval, the VFBC command interface and read interface must be reset for at least two clock cycles. Following the reset, the read command is written to the VFBC command interface. The VFBC read interface becomes non-empty several cycles following the command, and data can be popped off of the read interface FIFO.

Figure 13 shows a transfer for a single 576p line.

**Note:** The VFBC<Port_Num>_Rd_End_Burst signal must be asserted on the last word transfer because 720 is not a multiple of the VFBC burst size of 32 words. In this example the assertion occurs on the 719th pixel read. The following table shows the command words written to the command interface during the horizontal blank interval for the transfer of the first 576p line. The X Size is 720*4 bytes. The Y Size must be zero (denoting a single line transfer), and the Stride is ignored and can be any value. This example shows the Stride set to zero. The next line transfer has a Start Address of 0x1000_00B40. Each subsequent line transfer Start Address increments by 0xB40 during each horizontal blank interval.

<table>
<thead>
<tr>
<th>Command Word 0</th>
<th>Command Word 1</th>
<th>Command Word 2</th>
<th>Command Word 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:15 Reserved</td>
<td>14:0 X size</td>
<td>31 Write_NotRead</td>
<td>30:0 Start Addr.</td>
</tr>
<tr>
<td>0x0000_0B40</td>
<td>0x1000_000</td>
<td>0x0000_0000</td>
<td>0x0000_0000</td>
</tr>
</tbody>
</table>

**A Simple Interlacing and De-interlacing Example**

The VFBC PIM can be used for simple video processing such as interlacing or de-interlacing. The following tables show the VFBC commands to write a 480i source into a 480p frame store. As with the 1080p to 480p example, the X Size is set to 720*4 (0xB40). The Y size is set to 240-1 (0xEF) because a 480i field contains 240 lines.
There is a different VFBC command for each top and bottom field. The data is interleaved into the frame store by configuring the Stride to be two line lengths (2880*2, or 0x1680) and offsetting the bottom field Start Address by 720*4 (0xB40).

<table>
<thead>
<tr>
<th>Command Word 0</th>
<th>Command Word 1</th>
<th>Command Word 2</th>
<th>Command Word 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:15 Reserved</td>
<td>14:0 X size</td>
<td>31 Write_NotRead</td>
<td>31:24 Reserved</td>
</tr>
<tr>
<td>0x0000_0B40</td>
<td>0x9000_000</td>
<td>0x0000_0000EF</td>
<td>0x000_1680</td>
</tr>
</tbody>
</table>

The 480p command is similar to the 480i command packets, except the Stride is now a single 480p line, 720*4 (0xB40), the same as the X Size. The Y Size is set to 480-1 (0x1DF). The Start Address is the same start address as the first line of the 480i top field (0x1000_0000). The following table shows the 480p command packet.

<table>
<thead>
<tr>
<th>Command Word 0</th>
<th>Command Word 1</th>
<th>Command Word 2</th>
<th>Command Word 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:15 Reserved</td>
<td>14:0 X size</td>
<td>31 Write_NotRead</td>
<td>31:24 Reserved</td>
</tr>
<tr>
<td>0x0000_0B40</td>
<td>0x1000_000</td>
<td>0x0000_001DF</td>
<td>0x0000_0B40</td>
</tr>
</tbody>
</table>

Refer to the Xilinx Video Starter Kit website for more information about the VFBC transfers, the VFBC HDL interface, and example systems.

### Appendix III: Design File Description

The following table provides design file descriptions.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>matlab_hwcs_script.m</td>
<td>MATLAB hardware co-simulation script</td>
</tr>
<tr>
<td>matlab_hwcs_script_top.m</td>
<td>MATLAB hardware co-simulation top-level script</td>
</tr>
<tr>
<td>vfbc.mdl</td>
<td>The main System Generator model</td>
</tr>
<tr>
<td>vfbc_hwcs.mdl</td>
<td>The System Generator model for hardware co-simulation</td>
</tr>
<tr>
<td>Sg_clk_config.m</td>
<td>The Blackbox configuration file for clock extraction</td>
</tr>
<tr>
<td>Simulink_hwcs_script.m</td>
<td>The Simulink based hardware co-simulation script</td>
</tr>
<tr>
<td>Stimulus_generator.m</td>
<td>The VFBC stimulus vector generator script</td>
</tr>
<tr>
<td>Edkprocessor_ddr2fix.m</td>
<td>The DDR2 IO pad workaround script</td>
</tr>
<tr>
<td>read420Header.m</td>
<td>The hardware co-simulation script for parsing the header text file</td>
</tr>
</tbody>
</table>
Appendix IV: Simulation Results

The following are sample runs for each frame size from the Hyper Terminal and MATLAB command window.

<table>
<thead>
<tr>
<th>Frame Size</th>
<th>wrFrameHeight</th>
<th>wrLineLength</th>
<th>rdFrameHeight</th>
<th>rdLineLength</th>
<th>numFrames</th>
<th>Initializing done</th>
<th>v3_c0</th>
<th>v3_c1</th>
<th>v3_c2</th>
<th>v3_c3</th>
<th>viFrameSize</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>600</td>
<td>800</td>
<td>600</td>
<td>800</td>
<td>1</td>
<td></td>
<td>3200</td>
<td>900000000</td>
<td>599</td>
<td>3200</td>
<td>480000</td>
</tr>
<tr>
<td></td>
<td>720</td>
<td>1280</td>
<td>720</td>
<td>1280</td>
<td>1</td>
<td></td>
<td>5120</td>
<td>900000000</td>
<td>719</td>
<td>5120</td>
<td>921600</td>
</tr>
<tr>
<td></td>
<td>1080</td>
<td>1920</td>
<td>1080</td>
<td>1920</td>
<td>1</td>
<td></td>
<td>7680</td>
<td>900000000</td>
<td>1079</td>
<td>7680</td>
<td>2073600</td>
</tr>
</tbody>
</table>

Start Memory Test
Memory test successful!
Stop Memory Test

Simulation Done!

Appendix V: Tool and IP Versions

The tool and IP versions used for this application note include the following:

- Xilinx ISE Design Suite 11.1 software
- System Generator 11.1
- MATLAB software R2008a
Appendix VI provides instructions for the following:

- “How to Add Multiple Nets to External Ports Using XPS GUI”
- “How to Change the MPMC Version from 4.02.a to 4.00.a”

**How to Add Multiple Nets to External Ports Using XPS GUI**

For this application, the DDR2-SDRAM peripheral needs to be configured by bringing up VFBC3 and VFBC2 internal nets to the top-level design as external ports. By doing this, these ports can later be exposed by System Generator during importing as described in “Importing the Basic Processor System into System Generator,” page 7. These exposed top-level ports can then be connected directly with other portions of the System Generator model. It is through the exposed top-level ports that a System Generator model interacts with the VFBC IP core.

1. Select **All** for Port Filters on the top right-hand corner.

2. Select multiple internal nets from DDR2_SDRAM peripheral, right-click, and select **Make External**.

3. Examine for correct net names and ports being brought up to the top-level as external ports.
How to Change the MPMC Version from 4.02.a to 4.00.a

After the design flows between System Generator and XPS are complete, certain peripherals in the current XPS base system may be changed or modified. This task is accomplished by either using the XPS GUI or directly editing the MHS file. In certain cases, it may be easier to make a direct edit to the MHS file as shown in the following example steps.

1. In XPS, open system.mhs -> modify it as shown:

```
BEGIN mpmc
PARAMETER INSTANCE = DDR2_SDRAM
# PARAMETER HW_VER = 4.02.a
PARAMETER HW_VER = 4.00.a
PARAMETER C_NUM_PORTS = 4
PARAMETER C_MEM_FARTNO = mt4hcf32t64x-53e
PARAMETER C_NUM_IDELAYCTRL = 3
```

2. Hardware -> Clean Hardware.
3. Save Project.
4. Back in System Generator, repeat the procedure in “Importing the Basic Processor System into System Generator,” page 7, by re-importing the XPS project.

Appendix VII: How to Migrate from XPS to SDK Design Flows

Adding and managing software applications in XPS is deprecated starting in release 11.1 and will become obsolete starting in release 12.1. The existing XPS project provided by this application note may still continue to be used until 12.1, but Xilinx highly recommends migrating the software portion to the SDK flow to take advantage of flexibility and advanced features in adding and managing software. Follow the step-by-step instructions that follow to migrate from an existing XPS flow to an SDK design flow. The same generic steps can also be used on other Sysgen/EDK design demos to accomplish the same migration paths between XPS and SDK.

How to Migrate to the SDK Flow

1. Open the System Generator model with the hardware co-sim block (vfbc_hwcs.mdl), double-click on the HWCS block, and click on the Edit software button to launch SDK (Software Development Kits).
Note: The ELF file does not have to be entered at this point.
2. Click **OK** to start creating the software project.

Now that you have a hardware design, you can start creating software projects for it. Before you can create C or C++ application projects, you have to first create Software Platform projects. To create a Software Platform project, click on the New icon below the File menu and select Software Platform.

For tutorials on how to get started with Xilinx Software Development Kit, select Help -> Cheat Sheets. For SDK on-line documentation, select Help -> Help Contents or the SDK icon in the Welcome page.

[Image of Next Steps window]

[Image of Xilinx Software Development Kit window]
3. Right-click on the system.xml SDK project → New → Project.

4. Select Software Platform (Wizard).
5. Enter the project name and click **Finish**.

6. Right-click on **SysGen_VFBC** → **New** → **Manage Make C Application Project**
7. Enter the Software Platform Project name, select **Empty Application** with no template, and click **Finish**.

![Managed Make C Application Project](image)

The SDK design cockpit should look similar to that shown in **Figure 14**.

![SDK Design Cockpit (example)](image)

**Figure 14**: SDK Design Cockpit (example)

8. The last step is to either create a new C code source file or add an existing one to the project. In this case, just add the existing one from C:\VFBC\C-code\vfbc.c.

The easiest way to add a C code source file to the VFBC (SysGen_VFBC) application project is to simple Copy & Paste or Drag & Drop the file into the project. Once the file is added, the project will be built and compiled automatically.
How to Iterate the Design between System Generator and SDK

By default, the ELF file is named after the application project name – **VFBC.elf** in this case. It is also located under the folder of the application project location.

Design iteration using the SDK is similar to that performed in XPS, but with more advanced features and functionalities. Once the C code is modified and saved, the software application will be rebuilt and recompiled automatically. This, in turn, generates a new ELF file that will then be used by System Generator to recompile and update the bitstream to the target board.

**SW Iteration**
1. SDK – Modify C code and make sure the software project is recompiled successfully.
2. SysGen – Click Compile and Update bitstream button.
3. SysGen – Simulate the design.

**HW Iteration**
1. SDK – Add new peripherals or modify existing ones.
2. SysGen – Re-import an XPS project into the SysGen design.
4. SDK – Modify C code accordingly.
5. SysGen – Re-simulate the design.

*Note:* Making HW changes requires a new design implementation through Place & Route.

### Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Description of Revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/01/09</td>
<td>1.0</td>
<td>Initial Xilinx release.</td>
</tr>
</tbody>
</table>

### Notice of Disclaimer

Xilinx is disclosing this Application Note to you “AS-IS” with no warranty of any kind. This Application Note is one possible implementation of this feature, application, or standard, and is subject to change without further notice from Xilinx. You are responsible for obtaining any rights you may require in connection with your use or implementation of this Application Note. **XILINX MAKES NO REPRESENTATIONS OR WARRANTIES, WHETHER EXPRESS OR IMPLIED, STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, IMPLIED WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT, OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL XILINX BE LIABLE FOR ANY LOSS OF DATA, LOST PROFITS, OR FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR INDIRECT DAMAGES ARISING FROM YOUR USE OF THIS APPLICATION NOTE.**